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Note : you will find tables of all keyboard shortcuts you can use with Compose, at the
end of this document.

The File menu

When launching Compose, the left side panel offers the user 3 ways to create a new

score:

● Quick creation : create one page with a default instrument (flute) in 4/4.

● Create from template : Use a template from a prepared library of templates.

You can specify the title, subtitle, composer and copyrights, the number of

measures as well as the time and key signatures.

● Import a MusicXML, MIDI or SMZ file : you can select one of your local files to

import it into Compose.

The options under the File menu are the following:

● New: This displays the 3 options above to create a new score.

● Save: This option lets you save your score to your MakeCloud account.

● Download: This will display options to download your score as a PDF or

MusicXML file.

● Share: This opens the Share dialog box that gives you the options for sharing

your score with others. Note: If your score has not yet been saved, you will be

prompted to do so prior to the Share dialog opening.

● Open in Practice: This will display the option to your score in the MakeMusic

Cloud Practice app.

● Assign: Click this option to open the MakeMusic Assigner app to assign the

open score to your available classes. This option is only available when logged in

to the MakeMusic Cloud with an account that has an active Teacher

Subscription.
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Score navigation

Once a score is open, it is displayed in the main area of the screen.

To navigate in the working space:

● Right-click anywhere in the working space and drag the content around.

● Use the mouse wheel for vertical motion (SHIFT + mouse wheel for horizontal

motion).

● To zoom in and out, right-click anywhere in the working space and while holding

down the right mouse button, use the mouse wheel. You can combine dragging

the score around and zooming. The mouse location keeps the same location in

the score. This makes it quite easy to navigate only with the mouse, with no

need for keyboard shortcuts. You can also use the standard CTRL+mouse

wheel to zoom in/out.

● You can navigate the score with the keyboard arrow keys combined with the

ALT key. It moves the score by small steps.

● The Home and End keys will respectively navigate to the beginning and end of

the score.

● The Page Up and Page Down keys will navigate vertically by a distance close

to the visible view height.

● CTRL and + will increase the zoom value.

● CTRL and - will decrease the zoom value.

The following icons help the navigation and are found to the right, above the score:

● Decreases the zoom level (zoom out)

● Increases the zoom level (zoom in)

● Toggles full screen mode

The highlighted object

● When moving the mouse over the score, the closest object is automatically

highlighted:
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● The highlighted color of an object is a message to the user, saying “Here I am,

you can click me!”

● There is only one highlighted object at any given time. If the mouse is too far

away from an object, there is no highlighted object.

The selected object(s)

● The selection tool is the default tool, active when no other tool is used. Its

shortcut is ESC.

This shortcut will also:

○ Disable the current tool.

○ Disable the entry cursor.

○ Disable the duration dot tool.

○ Set the current note entry layer to 1.

○ Disable the tuplet tool.

○ Cancel any object selection.

Note that if you work in full screen mode, Chrome may interpret the ESC key as

a request to exit the full screen mode, so Compose won’t react to it and will

need a second ESC key to react properly.

● To select an object, click on it.

● Most objects (notes, clefs, time signatures, bar lines, key signatures, text

symbols, chord symbols, endings, rehearsal marks, metronome, ...) will display

their property panel on the left side of the screen when they are selected. This is

where you can modify the properties of these objects.

● Selected objects are displayed as follows:
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● There can be one or more objects selected.

● The same object can be selected AND highlighted if the mouse is close to a

selected object, even though the graphic selected status overbears the

highlighted status.

● The arrow keys help you change which object is selected. Left and right

arrows will respectively select the note/rest that is to the left or right of the

currently selected note. Up and Down arrows can be used to select the upper /

lower note in a chord, but also select symbols attached to the note. For

instance, in the following case, using the Up arrow key would successively

select the accent, the staccato dot, the C note, the F note, the A note and finally

the slur:

Basic note entry (without the entry cursor)

● An empty score has all its measures filled with rests.

● The note tools have the following keyboard shortcuts. Using a shortcut simply

selects the tool in the palette, whether that palette is currently visible or not.

8 7 6 5 4 3 2 1

● Click on the staff to enter a note. There are several possible situations:

○ In an empty measure that contains a pause:

■ You can place the note value anywhere in the measure.
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■ A ghost sequence is displayed to show where the note/rest will be

entered.

■ When holding the ALT key, there are twice as many magnetism

divisions available, according to the context.

■ The full rest is removed, the new note is added and the measure is

filled with rests to complete its duration.

○ On an existing rest, the behavior is:

■ Replace the rest by a note; if it is longer than the original rest, it will

overwrite the content that follows that rest.

■ If it is shorter, then one or more rests will complete the original rest

duration

○ If the measure is not full, you can:

■ Insert a note/rest before or after any existing note/rest: the content

is shifted.

○ When entering a note that would overlap the measure content, the note is

automatically split into two (or more) tied notes.

○ Before you release the mouse button, the note can still be repitched.

● By clicking on an existing note you can repitch it or move it horizontally inside

the measure to reorder the existing notes/rests. However, if there is a duration

tool active, the duration of the note will be overwritten. To simply move/repitch

the note, use the selection tool (ESC).

● When adding a note (with a click) while holding down the SHIFT key, the

corresponding rest is added instead of the note, with the same rhythmic

duration.

● The DEL or← (backspace) shortcuts will remove the selected object. A note is

first replaced with its corresponding rest. If the rest is deleted, it disappears and

the following notes/rests are shifted to the left, leaving the measure incomplete.

With the current default editing options, this is the only way to get an incomplete

measure, as in other cases, it is always completed with rests.

● The S shortcut swaps the selected note/rest to its equivalent rest/note.

● The L shortcut flips the stem of the selected note; on slurs, hairpins, octavas

and some other symbols, it swaps the symbol above/below the staff.
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● The Alt + C shortcut switches the selected note between a normal note and a

cue note.

● The U shortcut adds/removes a tie starting from the selected note. According to

the context, it will switch between a normal tie, inverted tie, open tie and

inverted open tie.

● The Y shortcut will do the same, but on the note that is before the selected note.

This is useful when encoding notes, as you can enter the note and then tie it to

the previous note.

● The / (forward slash) shortcut breaks or joins the beaming between the selected

note and the note that precedes it. When used in combination with the CTRL

key, it will break the next level of beaming with the previous note.

● The . (period) shortcut adds a dot to the selected note/rest, providing that the

resulting note duration does not exceed the measure duration. It switches

between no dot, single dot and double dot.

● The : (colon) shortcut adds a grace note to the selected note. The grace note

can thereafter be edited as a normal note (repitch, move,...).

● The = (equals sign) shortcut adds a slashed grace note to the selected note.

● Adding a note while holding down the CTRL key will force beaming it with the

previous note.

● The T shortcut enables/disables the tuplet tool in the palette.

● The numbers 1 to 9 together with the CTRL key will enable the corresponding

tuplet (1:1, 2:3, 3:2, 4:3, 5:4, 6:4, 7:4, 8:12, 9:8)

● By adding a note above or below an existing note, the new note is attached to

the same stem to build a chord. The currently selected tool does not affect the

original rhythmic value of the chord.

● The letters A through G will repitch the selected note to letters equivalent pitch.

● With SHIFT, the letters A to G will add a chord note to the selected note.

● The following shortcuts move the selected note (or rest, if the rest has the

manual positioning option active) up or down:

↑+ CTRL: moves the note/rest a second up.
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↓+ CTRL: moves the note/rest a second down.

↑+ SHIFT: moves the note/rest an octave up.

↓+ SHIFT: moves the note/rest an octave down.

● The following shortcuts act on the selected note's accidental:

○ + changes the accidental to a semitone higher; on dynamics, goes

through the series from pppp to ffff; on hairpins, switch to a crescendo

hairpin; on a metronome marking, increases the tempo by steps of 4.

○ - changes the accidental to a semitone lower; on dynamics, goes through

the series from ffff to pppp; on hairpins, switch to a decrescendo hairpin;

on a metronome marking, decreases the tempo by steps of 4.

○ N sets the accidental to natural; if already present, hides it.

○ 9 browses through the enharmonic notes.

○ * (asterisk) shows/hides the note accidental.

○ For a staff with a drum map defined, accidentals are disabled but the +

and - keys will browse through the different note heads defined. For

instance, it is possible to define a snare drum on the C line with a

standard note head, and a rimshot snare drum on the same C line, with a

slashed note head. Using “+” and “-” will swap between both.

● Notes can be entered in 4 independent layers (they correspond to rhythmic

voices) per measure. The layers are displayed in 4 different colors. The following

shortcuts act to select the active layer :

○ CTRL + ALT + 1 : Layer 1

○ CTRL + ALT + 2 : Layer 2

○ CTRL + ALT + 3 : Layer 3

○ CTRL + ALT + 4 : Layer 4

○ CTRL + ALT + 0 : Automatic layer handling

Automatic layer handling is used to enter music so that the user does not need

to manually switch from one layer to the other:

○ When starting to enter notes in an empty measure (or in a measure with a

pause), layer 1 will be used.

○ The user should then complete the measure until layer 1 is full.

○ It will then automatically switch to layer 2. The same process happens
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with layer 3 and layer 4.

○ The ghost note displays a small "L1", "L2",... to show in which layer the

next note will be entered.

● The following shortcuts can be used to add/remove an articulation for the

selected note:

○ ‘ (apostrophe) : staccato

○ “ (quotation mark) : accent

○ _ (underscore) : tenuto

● The standard Undo / Redo functions apply for all operations. Their shortcuts are

respectively CTRL + Z and CTRL + Y (or also CTRL + SHIFT + Z for redo).

Note entry with the entry cursor

● The entry cursor tool is enabled/disabled by the I shortcut:

● When enabled, it displays a blinking entry cursor, specifying where notes will be

entered or modified:

● Click anywhere in a measure to place the entry cursor.

● Most of the above tools and shortcuts still apply, except when superseded by

the following behaviors.

● The ENTER key will add a note at the cursor pitch and time position, using the

current rhythmic duration tool. The entry cursor will move to the next position.

● The 0 (zero) key will add a rest at the cursor pitch and time position, using the

current rhythmic duration tool. The entry cursor will move to the next position.

● The following shortcuts moves the entry cursor:

→ To the next position.

← To the previous position.
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↑ Move the pitch cursor up.

↓ Move the pitch cursor down.

● Clicking on an existing note or rest will set the entry cursor to that time position.

● If the entry cursor is set on a rest or empty location, letters A through G will

enter a note of the corresponding pitch at that location and the entry cursor will

move to the next position.

● If the entry cursor is set on a note, the letters A through G (with SHIFT) will add

a chord note to the current note.

Note entry with the piano keyboard or with a MIDI device

The icon will show/hide a piano keyboard at the bottom of the application. Its

shortcut is SHIFT + K. It can be resized vertically by moving the gray separation bar.

You can shift the keyboard horizontally by dragging one of the keys with the right

mouse button.

The notes played while listening to the score will be displayed by default on the

keyboard.

A note played on a MIDI device connected to the computer will be displayed by the

keyboard and played by the current staff instrument. For this to work, you must ensure

that Chrome enables the use of the MIDI devices connected to the computer, as this is

not necessarily the case by default. Check also that the MIDI device is well recognized

and installed on your system (Windows, Mac OS). It sometimes may require the

installation of a specific MIDI driver.

Step by step note entry

To enter notes with the keyboard (virtual or real MIDI device), the entry cursor must be

active and blinking. It determines the location of the next entry.

● Playing a note on the virtual piano keyboard or directly on the MIDI device will

enter that note at the cursor position, using the current rhythmic duration tool.

The entry cursor is then moved to the next position. Pressing several keys

together will enter a chord, from an external MIDI keyboard.

● If the entry cursor is placed on an existing note or chord, playing a note will

9



repitch the note/chord and the cursor will move to the next entry.

Real time note recording

Set the entry cursor at the measure where the recording must start. It will start at the

beginning of the measure. Use the (Record) icon to display the real time recording

panel:

Pressing Start record, one count-off measure is played and the recording begins. The

notes will be displayed as stemless noteheads to provide feedback, but the final

transcription will be done when the recording stops (the Start record button now

displays Stop record).

The recorded notes will replace the current layer of the recorded measures (other layers

are not modified, so you can record one layer at a time for instance).

All other staves and layers will play while the recording progresses.

Once the recording is done, you can still change the quantize parameters to adjust the

precision of the notation. You can try different options and click Apply to see the

result. In the case of a keyboard recording, you can define the split point between left
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and right hands. The Keep original playback checkbox will keep the original playback

of your performance, so that it sounds exactly as you played it, even though the

notation may have been simplified. Once you are satisfied with the options, click the

Validate button, which terminates this recording.

See the section entitled Edit selection for more information about the 3 transcription

modes as they impact the resulting notation and readability.

Adding symbols

● Note symbols like articulations and ornaments are available in the property

panel of a note. This property panel appears when a note is selected. Other

symbols are located in the Dynamic, Text and Symbol menus.

● Whenever possible, click on a note head or rest to place a symbol. This will

associate it to the correct time position (for the playback effect) and you will

benefit from the automatic positioning mode, so that in most cases, the symbol

is correctly positioned with no further need for manual adjustment.

● Staff symbols (like dynamics, pedal, text expressions,...) can be moved by

clicking and dragging the symbol. However, the vertical position is by default

computed by the layout engine.

● Some types of symbols have a checkbox labeled Manual positioning in their

property panels. Checking this box will enable you to freely position the symbol,

with no interference of the layout engine. Unchecking it will force the layout

engine to determine its position.

● Moving the mouse will highlight symbols and notes

● Clicking on a symbol will select it. Clicking on a note to add a symbol will attach

it to the note.

● Using the DEL or← (backspace) shortcuts will remove the selected symbol.

● The letter V will select the last dynamic tool used, or the mf symbol.

● There is a history stack of tools that you select using a mouse click. The two

following shortcuts navigate this stack by reselecting the previously selected

tools :

○ H will select the previous tool in the history stack

○ J will select the next tool in the history stack
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This can be helpful when you write a score and need to use a few symbols that

have no shortcut defined. The first time, select the symbol with the mouse and

the next time you can navigate with these two shortcuts to select them.

Text menu

● The Rehearsal mark tool handles rehearsal marks. Click anywhere in a

measure to add a rehearsal mark. When selecting an existing rehearsal mark, a

property panel appears, letting you choose the details of rehearsal marks.

● The Text tool is used to add a single style text block. Its shortcut is X. A

text block can be associated with the page or with a specific measure. If

associated with a measure, the text will follow that measure when the music

reflows, for instance during a new page layout setup. The property panel of a

text block lets you edit the text content, its font, color and alignment options.

For measure text blocks, you can specify a manual positioning, which lets you

position the text block independently of the layout engine. You can associate a

playback value (tempo value), associate it with a specific layer and specify if this

symbol must be included in the score individual parts.

● The Rich Text tool is a more advanced text tool that includes mixed font

styles, colors and alignment modes, as well as bullet lists, tabulation, line

spacing, background, border and text highlighting. The text is edited directly at

its position in the page or close to its associated measure. Its property panel

provides the interface to edit all its properties.

● The Lyrics tool is used to enter the lyrics mode. Its shortcut is O. The lyrics

cursor blinks under the current note. Existing lyrics have a light background

color (different colors for the 8 possible lyrics lines) :
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In lyrics mode, you can:

● Type in new characters.

● Use DEL or Backspace to delete a character.

● Use left and right arrows to either move the caret inside the current lyric

or to the previous/next note lyric.

● Use up and down arrows are used to reach the 8 possible lyrics lines.

● Use ENTER to go to the next lyric.

● Use the spacebar to move to the next lyric (except in the middle of a

lyric).

● Use SHIFT + space to add a space inside the lyric without moving to the

next.

● Use the _ (underscore) to add/remove an automatic extension line for that

lyric. It extends itself automatically, including all following notes that do

not have a lyric for that line.

● Use the - (hyphen) to add/remove a hyphen between this lyric and the

next one.

● Use TAB or SHIFT + TAB to go the next/previous lyric

● Click in a lyric to set the text cursor position.

● As a consequence of using the lyrics mode, many of the shortcuts

defined elsewhere in this manual won’t work anymore, as the characters

are used to enter lyrics.

● The left property panel enables you to edit the lyrics font, color and

alignment, either for all lyrics, the current lyrics line, or only the lyrics

under the cursor. You can also enable lyric line numbering by clicking the

Lyric Line Number and applying a numbering option. The checkbox

Enable manual line positioning will display small handles to the left of

the lyrics lines; you can drag them up/down to adjust the position of the

lines. Note that in this case, the layout engine won’t adjust the lines
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automatically anymore and you are responsible for placing the lines

correctly.

● The Chord tool is used for entering and editing chord symbols. Its shortcut

is Q. Click to add a new chord symbol or click on an existing chord symbol to

select its property panel, letting you edit the details of the chord symbol.

● The other items of the text menu provide 5 categories of predefined text

symbols, commonly found in music scores. Select one of them and click where

you want to add it. You can thereafter edit their properties in the left panel.

Line menu - Multi note symbols

● For slurs, hairpins, octavas, pedal lines, glissandi and general lines, add the

symbol by clicking around the start-point, drag the mouse and release the

button around the end-point of the symbol.

● To modify an existing multi note symbol, click and drag its handles.

● These symbols can be extended over more than one measure, as well as over

system breaks.

● You can add slurs and hairpins while entering music, using the following

keyboard shortcuts, applied on the selected note :

○ < or > : start a crescendo hairpin on the selected note. It is displayed in

red until you use it again on another note to terminate it.

○ ( or ) : start a slur above or below the selected note. It is displayed in

red until you use it again on another note to terminate it.

○ These same shortcuts, if used when there is no selected note, will simply

select the corresponding tool in the line menu.

Score tools

● The Clef tool is used to edit an existing clef or inside a staff to add a new

clef. Its shortcut is CTRL + F.

● The Key signature tool is used to edit an existing key signature or inside a

staff to add a new key signature. Its shortcut is K.

● The Time signature tool is used to edit an existing time signature or inside a

staff to add a new time signature. Its shortcut is ALT + CTRL + T.
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● The Metronome tool is used to edit an existing metronome symbol or

inside a staff to add a metronome marking. Its shortcut is SHIFT + T.

● The Staves and measures tool will display the pencil icons for each

staff and each measure. Its shortcut is M.

Clicking on one of these will either highlight a full staff (from first to last measure of the

score) or a full measure (one measure for all staves of the score). The corresponding

property panel will give you the following options:

● Add/remove measures

● Add/remove instruments

● Measure numbering options

● Grouping staves and handling brackets

● Editing the staff labels

● Handling pickup measures and incomplete measures

● Adjust transposition

● Define percussion maps

● Reorder staves

● The Custom spacing tool allows you to manually adjust the horizontal

positions of notes inside the measure. The default spacing is displayed as

follows:

By dragging these handles horizontally, you can for instance get the following

custom spacing:
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The handles now display in red, showing that the spacing of this measure has

been customized. You can clear the custom spacing by clicking inside the red

cross that is present on the first beat of the measure. The default spacing is then

applied to the measure.

Resizing measures

When you move the mouse over a bar line, you will see a round handle at the top of it:

You can drag it horizontally to move the bar line and so resize the measures. This is

how to customize the width of a measure. This is defined independently for each view

(linear, page or part view). This custom width option is now associated with the

measures. If you change the page layout or add or remove measures, each measure

will keep its custom width reference. Compose may however slightly adjust it when

aligning a new system setup on the left and right margins.

When there is at least one custom measure width inside a system, you will also see a

small “x” under the bar line:

Clicking in it will cancel any custom measure width present in that system and

Compose will recompute the layout of that system back to its original setup.
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Page Layout

The Page layout tool helps you re-organize the page layout. Its shortcut is P.

When this tool is active, the score displays the frames (there is one frame per page,

specifying the margins inside which the systems are distributed), the systems, and the

page borders.

System Layout

By clicking on a system, the score displays handles and buttons:

The handles let you resize a system horizontally and move it vertically. You can also

adjust the relative positions of staves within the system, by using the handles on the

left of each staff.

Be sure to check the option called Keep system margins during editing in the

Display & editing options (see next section) as otherwise Compose will cancel any

custom adjustment you made whenever it needs to update the page layout.

The large buttons act as follows:

● Moves the last measure of a system to the beginning of the next system.

Only the current system and the next system are modified.
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● Moves the last measure of a system to the beginning of the next system.

However, the next system keeps the same number of measures and its last

measure is moved to the next system, and so on up to the last system of the

score.

● Moves the first measure of a system to the end of the previous system.

Only the current system and the previous system are modified.

● Moves the first measure of a system to the beginning of the previous

system. However, the previous system keeps the same number of measures and

its first measure is moved to the previous system, and so on up to the first

system of the score.

● Moves the system to the next page. Only the current and next pages

are modified.

● Moves the system to the previous page. Only the current and

previous pages are modified.

When a system is selected as shown above, its property panel appears in the left part

of the screen. You can modify the indentation and vertical position by clicking the

Apply button.
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Frame Layout

By clicking on a frame (between systems or before an indentation), the score displays

its handles:

The handles let you adjust the frame in which the systems are distributed, which is

similar to setting the margins of the page.

When a frame is selected as shown above, its property panel appears in the left part of

the screen. You can modify the margins by clicking the Apply button. Each value can

be applied to the current page or to all pages.

19



Page Layout

By clicking in a page, but outside of a system or frame, the whole page layout is

selected for that score:

The page layout properties are then displayed to the left and you can recreate a new

page layout by choosing the parameters you want, like the paper size, staff size,

optimization and specification for the number of measures per system.

Page view, scroll view and part views

The default display is the page view for the conductor score (full score). You can

change the view with the following drop down menu just above the score:

The scroll view will display the full score as a unique system of staves, in which you

can navigate horizontally.
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The page view shortcut is SHIFT + P and the scroll view shortcut is SHIFT + S.

From the third line down, you can display the page view of individual parts for each

instrument. Note that a score with only a single instrument in page view will not create

a part.

According to your preferences and to the type of work you are doing, you can edit the

score content in any of these views simply by switching the above drop down menu.

Display & Editing options

The Display and Editing tool in the Score menu displays various options for

display and editing:

● Display in concert pitch: this option can be independent for each view.

● Show hidden notes and symbols: this option allows you to toggle the display

of hidden notes and symbols. When unhidden, these objects are shown in grey.

● View pages in column: this controls the orientation of the pages as either

vertical or horizontal.

● Display system divider: shows system dividers while in score view. The divider

markers are visible on export to PDF.

● Keep system breaks in parts: with this option, the page layout of parts will

keep the same system breaks as defined in the score page layout.

● Disable multimeasure rests in parts: this option will disable multimeasure

rests in parts.

● Keep system margins during editing: by default, as you create and update

your score, the layout engine will progressively adjust the layout of staves and

systems so that spacing is clean and no overlap of symbols occurs. You can

disable this by checking this checkbox. With this option enabled, you can then

manually adjust the layout of systems and staves and Compose won’t readjust

them anymore. Use this option when you want to keep full control on the page

layout of systems and staves.

● Rebuild part: this button is active only when in part view and will force

Compose to recompute the page layout of that part, taking into account some of

the above options.
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Playback menu

The Playback options menu has options that allows you to customize certain

playback aspects of your document.

● Swing: This defines the swing value used for the start of the score and provides

options for swing amount and duration. Note that swing can be turned off or its

parameters adjusted, by way of a text expression, at any point in the score.

● Dynamics: The dynamics compression curve can be used to easily extend the

range of dynamics (you can drag the two values up and down). The default value

should suffice in most cases, but you can “boost” the dynamics for instance by

setting the full range from 0% to 100%, or attenuate it for instance with 40 to

60%.

The default values of all dynamics are also defined here in terms of % of the full

range of loudness. They apply to the whole score. The default intensity is also

defined (in case of a score that has no nuances at all). Further down, the

accents, hairpins and sforzando playback values are defined.

Dynamic playback values can be edited for each individual symbol placed in the

score, through the property panel that appears once a symbol is selected.

● Glissando, bend, and pitch symbols: Clicking the Enable all pitch effects

option will turn on the playback effects for glissando Lines and Symbols that

affect pitch, like bends, scoops, doits, and falloffs. Alternatively, clicking Disable

all pitch effects will turn off all playback effects for these symbols and lines.

● Garritan sampler quality: These options specify how the Garritan sound library

will be used. You can specify how many samples are loaded per octave, and if

all velocity layers will be used. As samples need to be downloaded, increasing

the quality may impact the loading time, specifically for scores with several
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instruments. The Enable range extension checkbox is used to enable notes

that are normally outside the range of the instrument samples. These

“extended” notes are played by pitch shifting of the closest existing sample for

that instrument. The Load all samples button will update the loading of any

missing sound sample after you modify the quality options.

● Rebuild playback: Click this button to re-initiate Compose’s audio engine to

update any changes that were made with the playback settings.

The Mixer (SHIFT+M) option opens Compose’s mixer interface. This can be used

to independently adjust each staff’s level (in dBs) and pan. Each channel also has a

solo and mute option as well.

The Volume fader to the far right is the main volume channel. This controls the over all

volume output of your score. There is one Effect channel, as well that contains a

reverb effect. The drop down menu in this channel allows you to select the type of

reverb sound you want and the fader controls the amount of reverb.

Please note that, with the exception of pan, all of the mixer settings will affect

playback in the Practice app for assignments and shared documents.

Playing the score

The Play icon starts the playback of the score. You can also start and stop

playback with the spacebar. The start measure of playback depends upon the context.

Here are the rules:

1. If the entry cursor is blinking, the playback starts in the measure that contains

the cursor

2. If a single note or rest is selected, the playback starts in that measure

3. If a full measure (or more) is selected, the playback starts there

4. If there is one or more objects selected, the playback starts there

5. If none of the above conditions is present, the playback will start at measure 1 in

page view, or at the first fully visible measure in scroll view.
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The Pause icon pauses playback. The same icon, or the play icon, will resume

playback. The Stop icon stops playback.

The Edit Menu and Edit Selection Options

The Edit menu provides options that include undo and redo, and the Clipboard
Management tools and are meant to provide a location to utilize the Object selection
Edit Selection features quickly and easily.

When a measure or part of a measure, or even some objects are selected, the Edit

selection property panel appears and lets you apply specific changes to the selection.

According to the context, these changes are the following.

● Transpose: you can select the details of the transposition you want to apply.

● Change layer: the selection can be moved from one layer to another.

● Notes & Symbols: here you can change the properties of symbols or notes that

are inside the selection.

○ Flip note stems, single symbols, slurs, hairpins & dynamics

○ Mute/Unmute notes

○ Show/Hide notes

○ Show/Hide courtesy accidentals

○ Enable/Disable AlphaNotes (Letter Names)

○ Add/Remove most symbols and ornaments to a note

○ Change the note heads

Click Apply to apply the changes.

● Measure notation: change the appearance of the measures, like a repeat,

double repeat, hiding content or note heads.

● Multimeasure rests: create, break or split a multimeasure rest.

● Staff lines: define which lines of the staff are visible

● Transcription: used to re-transcribe the selected measure content, as though it

was played from a real time MIDI recording. There are 3 possible modes used

by the transcription engine and with this option you can change its default

behavior for the score and also apply it to change the way the existing measure

content is transcribed. The 3 transcription modes are :

○ Simplified notation - Uses one layer, with single chords (a note that is
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longer on a chord won’t be visible as such).

○ Single rhythmic line - Uses one layer, combining multiple chords with

ties, so that the music is represented as close to its playback as possible.

○ Multiple rhythmic lines - Analyze voicing for multiple layers, to make the

music as readable as possible

According to the type of music, each mode has its pro/con. Here is a simple

example showing the difference of notation, for the same playback:

Object selection and the clipboard management

As mentioned before, clicking on an object will select that object and display its

property panel for editing that object. The selected object can also be copied into the

clipboard using CTRL+C or the icons, located in the Edit menu.

It is possible to select more than one object. In this case, the property panels of the

objects are not displayed, but you can use the selection for copy/paste operations and

for some global changes applied to the selected areas of the score.

In Compose, you can choose to select objects individually, in full measures or stack of

measures, and partial measures. Depending on what type of area has been selected,

the Edit menu and properties panel can vary.

Selection of individual objects

● Click on the object: it is selected and its property panel is displayed.

● Click while holding the CTRL key: this object's selection is toggled; use it to add

another object to the selection or to deselect an object that is already part of the

selection.

25



● Click while holding the SHIFT key: only valid for a note, it will extend the

selection from the last selected note to the current note. It is an easy way to

select a melodic line.

● Starting outside a measure and with no highlighted object, drag a free rectangle.

When released, the objects inside that rectangle will be selected. If done while

holding down the CTRL key, the objects are toggled in/out of the selection. If

done while holding down the SHIFT key, they are added to the selection.

Selection of a block of measures for one or more staves

● Click inside a measure to select it.

● Clicking while holding the SHIFT key will extend the selected block
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● Clicking while holding the CTRL key will add the measure to the existing

selection; this makes non-consecutive measure selection possible.

● Double-clicking to the left of a staff will select the whole staff (from first to last

measure of the score); holding SHIFT will extend the selection and CTRL will

toggle that staff.

● Double-clicking just above a measure will select the stack of measures below

that location; holding SHIFT will extend the selection and CTRL will toggle that

stack of measures.

● Double-clicking elsewhere will select all measures on all staves (the full score). It

can also be done with CTRL + A (select all)

Selection of a partial range of measures for one or more staves

● Click inside a measure and drag the mouse to select the expected time section,

on one or more staves. Holding the SHIFT key will extend the closest range of

selected measures. Holding the CTRL key will add the new range to the existing

selection.
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● You can build a selection that combines one or more of each of the 3 selection

operations.

● An additional and specific mode enables to select one or more symbols, like

this:

● The sequence of symbols can then be copied and applied on any other

sequence of notes. For this to happen, there must be no other types of selection

than symbols.

Cut/Copy/Paste/Delete

Based on the current selection, the standard cut/copy/paste/delete operation icons can

be used.

● Copy the selection into the clipboard (also by CTRL + C )

● Paste the current clipboard content to the current selection (also by CTRL +

V ). In case of a complex type of selection combining all the above described
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modes, the exact location of the destination of the operation is determined by

priority to be:

○ The beginning of the first measure and first staff of the first block

selection.

○ If no block selection exists, then it is the beginning of the first measure

and first staff of the first partial range selection.

○ If no partial range selection exists, the first individual object determines

the location where the paste operation will be executed.

When pasting a complex and/or non-consecutive selection, the content is first

concatenated into a continuous and time ordered sequence, then pasted at the

destination. If more than one staff is copied/pasted, the destination offsets of the

staves stay consistent with the source of the original staves.

● Makes a copy of the current selection to the current clipboard and deletes

the selection from the score (also by CTRL + X ).

● DEL or Backspace deletes the content of the current selection.

● When combining a paste operation with the SHIFT key, you will be asked how

many times you want to paste the content of the clipboard to the destination

measure and Compose will then paste that content several times, one after the

other.

Clipboard manager

● The clipboard manager is displayed with the icon:

● When the clipboard contains music data, it is displayed as a miniature:
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● You can save the content of the current clipboard as a “saved clip” to be used

later. There can be as many of these saved clips that you want. They are

associated and saved with the current score. They are displayed in the lower

part of the clipboard manager:

● You can delete the clip or use the clip. When clicking on the Use button, the

content of that clip will follow the mouse cursor as a “ghost score” and will be

pasted at the exact location of the next click:

● New : If you hold down the SHIFT key, you will be asked how many times you

want to paste the content of the clipboard to the destination measure and

Compose will then paste that content several times, one after the other.
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● If the clip contains only individual symbols, they may be applied (dragged) on

the current selection and the symbols will be applied to all the notes of the

selection. This can be used to apply an articulation (or a sequence of

articulations) to a set of measures in one shot.

Drag and drop

● The copy/paste operations may be executed based on an intuitive drag and

drop feature.

● Clicking inside an existing selection in the score and dragging the mouse will

initiate a drag & drop operation. A “ghost score” follows the mouse and will be

pasted at the exact location where you release the mouse.

● This operation does not affect the current content of the clipboard.

● New : If you hold down the SHIFT key before dropping the content (but after

dragging it), you will be asked how many times you want to paste the content to

the destination measure and Compose will then paste that content several

times, consecutively.

* * * * * * * * * * * * * * * *
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Tables of all keyboard shortcuts you can use with Compose

Shortcuts
Score display & playback

Right Mouse Move the score around
Right Mouse

+ Mouse Wheel
Zoom in and out around the mouse position

CTRL + Mouse Wheel Zoom in and out around the mouse position
SHIFT + P Select the page view
SHIFT + S Select the scroll view
HOME Go to the beginning of the score
END Go to the end of the score

Page Up Move up the height of the display area
Page Down Move down the height of the display area
CTRL + "+" Increase the zoom display
CTRL + "-" Decrease the zoom display
SHIFT + K Show/hide keyboard
ALT +← Moves the score to see the left part
ALT +→ Moves the score to see the right part
ALT + ↑ Moves the score to see the upper part
ALT + ↓ Moves the score to see the lower part
SPACE Start / Stop playback

General shortcuts
CTRL + C Copy to the clipboard
CTRL + V Paste from the clipboard
CTRL + X Cut to the clipboard
CTRL + Z Undo last operation
CTRL + Y Redo the last operation
CTRL + A Select the whole score

Selection of tools
Note entry

8 Select the double whole note tool
7 Select the whole note tool
6 Select the half note tool
5 Select the quarter note tool
4 Select the 8th note tool
3 Select the 16th note tool
2 Select the 32nd note tool
1 Select the 64th note tool
T Enable/disable the Tuplet tool for note entry

CTRL + 1 Set tuplet entry to 1:1 (no tuplet)
CTRL + 2 Set tuplet entry to 2:3
CTRL + 3 Set tuplet entry to 3:2
CTRL + 4 Set tuplet entry to 4:3
CTRL + 5 Set tuplet entry to 5:4
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CTRL + 6 Set tuplet entry to 6:4
CTRL + 7 Set tuplet entry to 7:4
CTRL + 8 Set tuplet entry to 8:12
CTRL + 9 Set tuplet entry to 9:8

CTRL + ALT + 0 Select automatic layer entry
CTRL + ALT + 1 Select layer 1
CTRL + ALT + 2 Select layer 2
CTRL + ALT + 3 Select layer 3
CTRL + ALT + 4 Select layer 4

I Enable/disable the blinking note entry cursor

Score tools
CTRL + F Select the clef tool

K Select the key signature tool
ALT + CTRL + T Select the time signature tool

SHIFT + T Select the metronome tool
M Select the measure/staff tool
P Select the page layout tool

Other tools
V Select the MF tool or the last dynamic used
X Select the text tool
O Select the lyrics tool
Q Select the chord tool

ESC
Select the selection tool; layer set to 1;
reset tuplets and dots; hide entry cursor; unselect all

H Select the previous tool in the history of mouse selected tools
J Select the next tool in the history of mouse selected tools
< Select the crescendo hairpin tool
> Select the decrescendo hairpin tool
( Select the upper slur tool
) Select the lower slur tool

Note entry
Modifiers when entering notes

SHIFT Enter the equivalent rest of the selected note tool
CTRL Will force beaming with the previous note
ALT Rhythmic position magnetism precision doubled

Action on a selected note (or rest)
← Select the previous note or symbol
→ Select the previous note or symbol
↑ Select the previous note or symbol
↓ Select the previous note or symbol

ABCDEFG Repitch the note to the closest note
SHIFT + ABCDEFG Add a note as a chord note to the selected note

CTRL + ↑ Move the note (or rest) a second up
CTRL + ↓ Move the note (or rest) a second down
SHIFT + ↑ Move the note (or rest) an octave up
SHIFT + ↓ Move the note (or rest) an octave down
DEL or

Backspace
Delete the note, rest or symbol; a note is first
replaced with a rest
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+ Up one accidental
- Down one accidental
N Set accidental to natural; show/hide it
9 Browse through the enharmonic of the note
* Show/Hide accidental
S Swap between note and rest
L Flip the note stem up/down

ALT + C Swap between normal/cue note or rest

U
Switch tie : none, normal, reverse, normal open,
reverse open according to context

Y Switch tie on the previous note
/ Break / join the beaming with the previous note

.
Swap between normal, dotted, double dotted
note or rest

: Add a grace note to the selected note
= Add a slashed grace note to the selected note
' Add/remove Staccato
" Add/remove Accent
_ Add/remove Tenuto
< > Start of hairpin on the note (cresc - decresc)
< > End pending hairpin on the note
( ) Start of slur on the note (above - below)
( ) End pending slur on the note

Note entry with MIDI cursor
ABCDEFG Add a note + move the cursor to next position

SHIFT + ABCDEFG Add a chord note
ENTER Add a new note or a chord note at the cursor

0 Add a new rest at the cursor time position
← Move the cursor to the next position
→ Move the cursor to the previous position
↑ Move the pitch cursor up
↓ Move the pitch cursor down

Action on some selected symbols

+
Dynamics: up (pppp --> ffff);
Hairpin to crescendo

-
Dynamics: down (ffff --> pppp);
hairpin to decrescendo

+ Metronome: tempo up by multiples of 4
- Metronome: tempo down by multiples of 4
L Flip slur/hairpin/symbols above/below the notes

Modifiers when selecting objects
CTRL Toggle the clicked object in/out of the selection
SHIFT Extend the selection
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